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Focus on Inquiry 
The student will focus on inquiry by determining independent and dependent variables and developing a hypothesis. 
During the experiment, students collect and record soil temperature data.  Then they will create a line graph and 
analyze the data. 
 

Lesson Overview 

Students will analyze the relationship between four different soil coverings and its effect on soil temperature.   
 

Duration 
1-2 class periods 

Setting 
Computer Lab/Classroom 

Grouping 
Groups of 4 

PTI Inquiry Subskills 
1.3, 2.1, 2.2, 2.5, 2.6, 3.1, 3.2, 
3.5, 3.7, 3.8, 4.2, 4.3, 5.2, 5.3, 
5.8, 7.2, 7.3 

 

Lesson Components 
Estimated 

Time 

Inquiry 
Subskills 

Used 

Technology 
Used 

Level of 
Student 

Engagement 
Brief Description 

Engage 
10  

minutes 
5.8 

Overhead 
projector 

1 
Students interact in a class discussion 
about the reflection of sunlight. 

Explore 
35 

minutes 

1.3, 2.1, 
2.5, 2.6, 
3.1, 3.2, 
3.5, 3.7, 

3.8 

Microsoft 
Excel 

3 

Students formulate a hypothesis and 
then conduct an experiment by 
collecting soil temperature data with 
various types of soil covering. 

Explain 
25 

minutes 

2.2, 3.8, 
4.2, 4.3, 
5.2, 5.3, 
7.2, 7.3 

Microsoft 
Excel 

3 

Students identify variables in the 
experiment, create a line graph to 
better analyze the data, and use the 
data collected to determine the 
relationship between soil covering and 
temperature. 

Expand 1-2 days 

2.1, 2.6, 
3.1, 3.2, 
3.5, 3.7, 
4.3, 5.2, 
5.3, 5.8, 

7.2 

Computer/ 
Internet 

3 

Students research types of heat 
energy transfer and connect how 
ground cover affects energy transfer.  
Students conduct the experiment again 
using recommended and different soil 
coverings such as ground cover. 

Evaluate     
Answers to student lab reports and 
teacher generated rubric or checklist 
for graph requirements. 

Level of Student Engagement 
1 Low Listen to lecture, observe the teacher, individual reading, teacher demonstration, teacher-centered instruction 

2 Moderate Raise questions, lecture with discussion, record data, make predictions, technology interaction with assistance 

3 High Hands-on activity or inquiry; critique others, draw conclusions, make connections, problem-solve, student-centered 
 

National Science Education Standards – Inquiry 
Design and conduct a scientific investigation 
Use appropriate tools ant techniques to gather, analyze and interpret data. 
Develop descriptions, explanations, predictions, and models using evidence. 
Communicate scientific procedures and explanations. 
National Science Education Standards – Earth Science 
Global patterns of atmospheric movement influence local weather. 

 Oceans have a major effect on climate, because water in the oceans holds large amounts of heat. 
Louisiana Grade Level Expectations – Inquiry 
Gr. 8, Inquiry GLE#4-Design, predict outcomes, and conduct experiments to answer guiding questions (SI-M-A2) 
Gr. 8, Inquiry GLE#5-Identify independent variables, dependent variables, and variables that should be controlled in designing 
an experiment (SI-M-A2) 
Gr. 8, Inquiry GLE#6-Select and use appropriate equipment, technology, tools, and metric system units of measurement to 
make observations (SI-M-A3) 
Gr. 8, Inquiry GLE#7-Record observations using methods that complement investigations ( journals, tables, charts) (SI-M-A3) 

Discovering How Reflection of Sun’s Rays Effects 
Soil Temperature 

Adapted from:  Discovering Albedo found at: 
http://www.scienceteacher.org/k12resources/lessons/lessonA27.htm 

http://www.scienceteacher.org/k12resources/lessons/lessonA27.htm
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Gr. 8, Inquiry GLE#8-Use consistency and precision in data collection, analysis, and reporting (SI-M-A3) 
Gr. 8, Inquiry GLE#9-Use computers and/or calculators to analyze and interpret quantitative data (SI-M-A3) 
Gr. 8, Inquiry GLE#11-Construct, use, and interpret appropriate graphical representations to collect, record, and report data 
(e.g., tables, charts, circle graphs, bar and line graphs, diagrams, scatter plots, symbols) (SI-M-A4) 
Gr. 8, Inquiry GLE#12-Use data and information gathered to develop an explanation of experimental results (SI-M-A4) 
Gr. 8, Inquiry GLE#13 – Identify patterns in data to explain natural events (SI-M-A4) 
Gr. 8, Inquiry GLE#14 - Develop models to illustrate or explain conclusions reached through investigation (SI-M-A5) 
Gr. 8, Inquiry GLE#16 – Use evidence to make inferences and predict trends (SI-M-A5) 
Gr. 8, Inquiry GLE#19-Communicate ideas in a variety of ways (e.g., symbols, illustrations, graphs, charts, spreadsheets, 

concept maps, oral and written reports, equations) (SI-M-A7) 
Gr. 8, Inquiry GLE#22 - Use evidence and observations to explain and communicate the results of investigations (SI-M-A7) 
Gr. 8, Inquiry GLE#23 – Use relevant safety procedures and equipment to conduct scientific investigations (SI-M-A8) 

Louisiana Grade Level Expectations Earth Science  
Gr. 8, GLE #52-Describe the relationship between plant type and soil compatibility (SE-M-A9) 

 
Materials List (per group)

 Plastic one-gallon milk jugs; cut to 18 cm high (four per group)  

 Thermometers 

 Rulers  

 Soil mixture (all students need to use the same type of soil)  

 Various types of covering to be put on the soil samples (white paper, black paper, newspaper, packing 
peanuts, use your imagination)  

 Access to strong natural sunlight or heat lamps or 100-watt bulbs  

 A timing device (i.e. stopwatch) 

 Computer with Internet Access and Microsoft Excel 

 Overhead projection (One for class) 

Advance Preparation 
1. Gather materials necessary to complete lab.  Note:  Heat lamps may be a safety issue. 
2. Make sure each group will have access to a computer with Microsoft Excel. 

 
Other Information 
Learning Objectives 

 Read a thermometer accurately.  

 Collect and record data.  

 Generate a graph based on data. (Student can use Excel or other software to create line graphs.) 

 Identify independent and dependent variables.  

 Determine which covering affected soil temperature the most.  

 Analyze data and make conclusions concerning how soil coverings affect soil temperature. 

 
Prior Knowledge Needed by the Students 

 Microsoft Excel 
 

Procedure 
 
Engage 

1. Using an overhead projector or other light source, demonstrate how light is reflected. 
2. Engage students in a class discussion about reflection of sun light off other surfaces and how that 

effects the temperature (e.g. Temperature inside of a parked car or similar).  See if the students 
can come up with other examples. 

3. Explain the activity to students. 
 

Explore  
1. Allow students time to conduct the lab activity found on the Blackline Master 1 . 

 

Explain
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1. Students answer questions on the Blackline Master 1 during the activity.  They may need assistance on the 

creating the line graph in Excel.  Here is a screenshot of a possible result: 
 

 
 
Expand  

1. Have the students research the types of energy transfer (radiation, conduction, and convection) on the Internet 
and document data on each type. (Note: Different groups could research a different type.) Then have students 
write a paragraph to connect the type of energy transfer to the experiment on how ground cover affects energy 
transfer.   

2. Have students contact greenhouses in the area for recommendations on soil cover.  Have students test 
recommended material by conducting the experiment again and see if any of their material worked better and 
provide reasons why or why not. 

3. Have the students predict what effect different types of ground cover (shrubs, grass, trees, etc.) have on soil 
temperature.  Have them test their predictions by conducting this experiment with those coverings.  
 

Evaluate 
1. Students can be assessed on the answers on the Blackline Master 1 as well as the line graph drawn. 

 
Blackline Master 

1. Discovering How Reflection of Sun’s Rays Effects Soil Temperature 
 
Supplementary Resources 
See website for additional information. 

 
Credits:  

Contributing Teacher: Don Samuelson 
NTEN Course: N/A 
Instructor: N/ADeveloping Team: T.L. Buck Buchanan, Patti Harrison, Don Samuelson, John Usher, Don Wilson 
HTML Programmers: Tyson N. Trebesch, Ryan Huddleston, Andy Tomascak, Ching-Kwong Chia 
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 Name:  _______________________________________ Date:  __________ Class Hour:  _______ 

 
Discovering How Reflection of Sun’s Rays Effects Soil Temperature 

 
Problem/Purpose:  How does soil covering affect the temperature of soil? 
 
Hypothesis:  ____________________________________________________________________ 
 
Materials:   

 Four plastic one-gallon milk jugs; cut to 18 cm high  

 Thermometer 

 Ruler  

 Soil mixture  

 Various types of covering to be put on the soil samples (examples: white paper, black paper, newspaper, 
packing peanuts, use your imagination)  

 Access to strong natural sunlight, heat lamps, or 100-watt bulbs  

 A timing device (i.e. stopwatch) 

Procedure:   

1. Using Microsoft Excel, open a new spreadsheet and save it on your desktop or another specified location as 
Soil Temperature.  Within the spreadsheet, create a table similar to the one below. 

2. Use the ruler to place 15 cm of soil into each of the four plastic milk jugs.  
3. Chose a different covering (you will need four different ones) to put on each sample of soil;                                   

cover each soil sample with a covering. See Materials List above for examples or use your imagination.  
Record each type of covering used in your Excel spreadsheet. 

4. Mark thermometer 2.5 cm from the bottom of its bulb. Make sure the mark does not cover any part of the 
scale.  

5. Place the four soil samples and their covering in an area where they will receive the same amount of light. 
(You can use natural sunlight or a heat lamp if it was provided to you.) Record the initial temperature of the soil 
at a depth of 2.5 cm. Remove the thermometer after each reading.  

6. Using the stopwatch or other timing device, record the temperature at a depth of 2.5 cm at five-minute 
intervals; try not to disturb the covering. Record your data in the Excel spreadsheet. 

Data table:  

 

Time (min) 

Temperature of 
Covering 1: 

_______________ 

Temperature of 
Covering 2: 

_______________ 

Temperature of 
Covering 3:  

_______________ 

Temperature of 
Covering 4:  

_______________ 

0 
    5 
    10 
    15 
    20 
    25 
    30 
     

Analysis: 
 
Note:  These directions may vary based on the version of Excel you have. 
You should have all the temperature data inputted into the Excel spreadsheet.  Now, produce a line graph with all four 
coverings plotted.  To do this, highlight columns B-D (temperature data) and go to the Insert menu to create a 2-D line 
graph with markers.  The time will be on the horizontal axis (independent variable) and temperature on the vertical axis 
(dependent variable). Go to the Layout menu to add a Chart Title (Soil Temperature) and Axis Titles (Time (min) and 

Blackline Master #1, pg. 1 
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 Temperature).  You can change the range of the temperature by highlighting the vertical axis, right-clicking, and 

choosing “Format Axis”.  Then change the Axis Options to Fixed with a Min value of 50, a Max value of 100, Major unit 
of 5, and Minor unit of 2.    You can also change the values of the time on the horizontal axis by highlighting the values, 
then go to the Design Tab and click on “Select Data”.  Under the Horizontal Axis select “Edit” and select your range to 
be the values in Column A.  Click OK and you should see the correct values here now.  This line graph shows the 
relationship between covering type and temperature.  Save or print this file. 
 

1. List the variables in this experiment:  Independent: __________________________________ 
      Dependent: __________________________________ 
 

2. Which covering caused the greatest temperature change over time? _____________________________ 
 

3. Which covering caused the smallest temperature change over time? _____________________________ 
 

4. List the coverings in order, from the one that produced the smallest change to the greatest change. 
 

a. _________________________________ 
b. _________________________________ 
c. _________________________________ 
d. _________________________________ 

 
5. What is the relationship between type of covering and temperature change?  
     ____________________________________________________________________________________ 

 
     ____________________________________________________________________________________ 

 
6. Why is time the independent variable? ____________________________________________________ 

 
       ___________________________________________________________________________________ 
 
       ___________________________________________________________________________________ 
 

Conclusion:   
 

1. Was your hypothesis supported or not? ___________________________________________________  
 
2. Why?  _____________________________________________________________________________ 

 
3. What did you learn by doing this experiment?  ______________________________________________ 

 
___________________________________________________________________________________ 
 
___________________________________________________________________________________ 

Blackline Master #1, pg. 2 


